Waters® Empower 3

Empower™ 3 software (build 3471) contains changes, new features, and enhancements.
These release notes contain the following information and instructions:

Operating system requirements

Processor and memory requirements

Issues fixed in previous versions of Empower software
Issues fixed in Empower 3 software

Known issues in Empower 3 software

GxP compliance requirements

Post-installation considerations

Empower 3 performance considerations

Empower calculation considerations

Using Empower 3 online Help

Test configurations

Use these release notes in conjunction with release notes that were issued for all previous
Empower service packs and feature releases. Unless superseded, all previous release note and
product support information apply to this software release.

See also: The following guides for detailed instructions on installing, configuring, upgrading,
and administering Empower 3 software:

Empower 3 System Administrator’s Guide
Empower 3 Installation and Configuration Guide

Waters Ethernet Instrument Getting Started Guide

For information about new features, see What’s New in Empower 3 on the Empower 3
documentation media.

W 1- Waters and Millennium are registered trademarks and Empower and “THE SCIENCE OF WHAT’'S POSSIBLE.” are trademarks of Waters Corporation.

All other trademarks are the sole property of their respective owners.
Copyright © 2010 Waters Corporation

THE SCIENCE OF
WHAT'S POSSIBLE™

* 7 150027 0 4 % * R E V . B *

Page 1 of 33



Operating system requirements

Empower 3 software is supported on the following operating systems:
e Personal workstation - Windows® 7 Professional or Enterprise, 64-bit

« Client or LAC/E*? - Windows 7 Professional or Enterprise, 64-bit; Windows XP Professional
SP3, 32-bit

e Windows database server - Windows Server 2008 R2 Enterprise, 64-bit

o Citrix® server - Windows Server 2008 R2 Enterprise, 64-bit, XenApp™ Server 6.0 with
client online plug-in 12

Unsupported operating systems

During installation, the Empower 3 software installer gathers information about your system
and compares your system configuration to the minimum required specifications.

o If the installer detects the Windows NT, Windows 2000, Windows XP 64-bit, or Windows
2000 Server operating system, it exits without installing the Empower 3 software.

o If the installer detects the Windows Vista 32-bit, Windows Vista 64-bit, Windows 7 32-bit,
Windows XP 32-bit (Empower 3 Personal software only), or Windows Server 2003
operating system, it displays an error message and prompts you to indicate whether to
continue the installation. This information is documented in the Empower 3 installation
log.

Although the Empower 3 software can be successfully installed on these operating
systems, Waters does not support such installations. Installation is allowed on these
operating systems for testing and development purposes only.

If you install Empower 3 software on a Windows 7 32-bit operating system, you must click
“Install” when the Windows Security Device Installation dialog box prompts you to install the
BusLAC/E drivers. If you select “"Don’t Install”, the Empower 3 installation fails and the
installer attempts to roll back changes. The roll-back process might not successfully remove
the Empower Instruments folder.

Tip: To prevent the security dialog box from appearing during future installations, select
"Always trust software from Waters Corporation”.

Empower 3 software does not support file server clustering or Waters Service clustering.
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Processor and memory requirements

The following table illustrates the minimum and recommended

requirements for Empower 3 software installation:

minimum hardware

Configuration Minimum Recommended
minimum
Personal/ Processor Core™ 2 Duo E6400, Core 2 Duo E8400,
. 2.13 GHz 3.0 GHz

Workstation

Memory 2 GB 4 GB

Hard drive 1 GB - -

(Empower 3

application)

Hard drive 1 GB - -

(Project

directory)

Hard drive 8 GB - -

(Oracle

application)
Enterprise Server Processor Intel® Xeon® 2 GHz Intel Xeon 2.7 GHz

(single or dual) (single or dual)

Memory 4 GB 6 GB

Hard drive 1GB - -

(Empower 3

application)

Hard drive 3 GB - -

(Empower 3

database)

Hard drive 1GB - -

(Project

directory)

Hard drive 5 GB - -

(Oracle

application)
Workgroup Server Processor Intel Xeon 2 GHz Intel Xeon 2.7 GHz

(single or dual) (single or dual)

Memory 2 GB 4 GB

Hard drive 1GB - -

(Empower 3

application)
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Workgroup Server Hard drive 3GB - -

(continued) (Empower 3
database)
Hard drive 1 GB - -
(Project
directory)
Hard drive 5GB
(Oracle
application)
Client or LAC/E>? Processor Core 2 Duo E6400 Core 2 Duo E8400
2.13 GHz 3.0 GHz
Memory 2 GB 2 GB

Hard drive 1 GB - -
(Empower 3
application)

Hard drive 5GB - -
(Oracle
application)

The Empower 3 installer checks the processor requirement, but does not display a warning
message or terminate the installation if it finds an incompatible processor. Processor
information is recorded in the Empower 3 installation log.

If your system does not meet the minimum memory requirements, the installer displays an
error message, and the installation is terminated. The installation log is updated with the
insufficient memory information. The memory sizes recorded in the installation log may be
rounded up from those reported as the computer properties.

If your system does not meet the hard drive space requirements, the installer displays an
error message, and returns you to the Custom installation page, where you can delete files to
create free disk space or select a different target drive. The installer checks the drive hosting
the Empower Projects directory for the suggested 1 GB of free space. If the drive does not
have the suggested free disk space, the installer displays a warning message, but allows the
installation to continue. The installer checks each of the free space requirements against the
target hard drive. If multiple Empower 3 components will be installed on the same hard drive,
the installer checks the hard drive to ensure there is adequate free space for the sum of those
components.

Waters NuGenesis SDMS and Empower 3 compatibility

Empower 3 Enterprise software is supported with SDMS 7.1 SR7, which is slated for release in
late 2010.

The core SDMS and Vision Publisher (VP) 7.1 software are not compatible with 64-bit Windows
operating systems or on Windows Server 2008 R2 operating systems. Because Empower 3
Personal software is supported on Windows 7 64-bit only, it is not supported with SDMS/VP.
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SDMS File Capture is compatible with 32-bit operating systems. For Empower 3 Enterprise or
Workgroup software, File Capture is supported running the Empower Remote Data Adapter on
Windows 7 Professional or Enterprise, 64-bit. The SDMS Archive Agent must be run on either
Windows XP SP3 32-bit or Windows 2003 Server R2 SP2 32-bit operating systems.

See “Installing NuGenesis SDMS data adapters” below for instructions on setting up Empower

3 file capture with SDMS.

SDMS Print Capture is compatible with 32-bit operating systems, but is not compatible with
64-bit operating systems. You must use a Windows XP 32-bit client to use Print Capture from
Empower 3 software. Hence, SDMS Print Capture from Empower 3 Personal is not supported.

Vision Publisher client and VP options such as Form Designer are compatible with 32-bit
operating systems, but are not compatible with 64-bit operating systems. You must use a
Windows XP 32-bit client to access Empower 3 data through Vision Publisher’s External
Systems screen.

Empower 3 support is structurally validated with SDMS/VP 7.1 SR7 only. Prior versions of
SDMS have not been tested with Empower 3 software.

Operating Empower 3 Waters NuGenesis SDMS 7.1 Service Release 7
System Enterprise
Windows Client NuGenesis Vision UNIFY | Archive | Empower | Empower
version VISION Publisher print Agent Remote Restore
client client capture data data
driver adapter adapter
Windows No Yes Yes Yes Yes (Yes) (Yes)
2003 Server
R2 SP2
32-bit
Windows XP Yes Yes Yes Yes Yes Yes Yes
Professional
SP3 32-bit
Windows 7 Yes No No No No Yes No
(Professional
or
Enterprise)
64-bit

Note: Entries in parenthesis indicate that while the respective component is compatible with
the operating system, it is not compatible with Empower 3 software.
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Issues fixed in previous versions of Empower software

The following table contains a list of the problems fixed in previous versions of Empower
software. The PCS (Product Change System) numbers identify software issues that Waters
personnel monitor within a system change request tracking tool.

PCS Number | Empower 2 | Description
version
44653 SPF HF1 When selecting an object in the Project window, you no longer
44596 receive a message about a required resource or Empower 3 no
longer closes unexpectedly. To fix this problem, memory leaks
for Graphics Device Interface (GDI) objects were resolved and
stay below the maximum limit of 10,000.
44654 SPF HF1 When you delete one or more rows in the Peaks table in the
44559 Review Window using either the Pro or QuickStart interface,
44586 the software no longer closes unexpectedly.

44698 SPG 44571 | When switching injections and updating the 2D and 3D
Channel tables in the Review window and QuickStart, the
software no longer closes unexpectedly.

44699 SPG 44209 | When you manually identify peaks (Named Group or Timed
Group) in the Review window and in QuickStart, the software
no longer closes unexpectedly.

44700 SPG 43590 | When you log into Empower 3 software as a non-
Administrator and open the View Sample History dialog box,
QuickStart and the Run Samples window no longer close
unexpectedly.

44701 SPG 44233 | While exporting data that contains fields with no values, the
software no longer closes unexpectedly.

44703 SPG 44311 | In MVM validation reports containing a Validation Test Data
table, the linearity test’s Response Factor (RF) and the
Relative Response Factor (RRF) were interchanged.

44705 SPG 41951 | The Review window and QuickStart no longer close
unexpectedly when the title of the project path contains more
than 100 characters.

44706 SPG 43340 | The first application windows to open were allocated excessive
amounts of memory by the Windows operating system.
Empower 3 applications were modified to override the
Windows defaults and allocate memory equitably.

44707 SPG 44610 | When using an LDAP user account, you can now enter your
LDAP password to confirm manual integration of a peak.

44917 SPG 43252 | When you export data containing fields that are too long to fit
on one line, the software no longer closes unexpectedly.

45240 SPG 45032 | When an Administrator presses the [Esc] key in the Your
Password has Expired dialog box, a logged-in user’s role is no
longer changed to Administrator.

45241 SPG 38016 | The Open Access user interface now opens correctly the first

42546 time and does not close immediately upon opening.
45755 SPG HF1 In the QuickStart and Review windows, you can no longer
45545 create results against a modified calibration curve without first
saving the calibration curve.
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45756

SPG HF1 In the QuickStart and Review windows, the following menu
45324 options have now been re-enabled, as they were in releases
prior to Empower 2 Service Pack G:

e Edit > Manual Coefficients (GPC Calibration Curve)

e Edit > Clear Calibration

e Navigate > Previous Purity Pass (Result window)

e Navigate > Next Purity Pass (Result window)

e Navigate > Previous Library Match (Result window)

e Navigate > Next Library Match (Result window)

46096

SPG HF2 An Oracle parameter has been implemented to improve
46265 database responses to Toolkit or client queries. This change is
intended to improve performance in wide-area network
(WAN) applications, but some improvement in local-area
network environments may also be noticed. This feature does
not have a significant effect when a large number of different
queries are executed (such as opening a project or bringing a
large number of results into Review), or with tasks involving
intensive non-database activity.

Issues fixed in Empower 3 software

The following table contains a list of the problems fixed in Empower 3 software. The PCS
(Product Change System) numbers identify software issues that Waters personnel monitor
within a system change request tracking tool.

PCS Number

Description

36203

Although chromatographic system comments were available in Empower
build 1154, they were not available in Empower 2 build 2154. The system
creation process recorded the system comment only as the reason for
creating the system and not as an entry into the audit trail.

The Empower 3 system creation process includes two comment fields:

e System Comment - Allows you to enter free text to describe the
system

¢ Comment - Provides information for the system audit trail

38260, 41333

In a Full Audit Trail project, the software now prompts you for a comment
(and password, if the “Confirm Identity” policy is enabled) each time you
attempt to delete an object using the Delete key.

38488 The "Export to text" function in Configuration Manager now displays the
correct information and list of projects for the selected user.

40277 The software now produces a signal-to-noise value when the USP option is
selected in a processing method’s suitability parameters.

40630 The System Monitor now displays the correct number of installed user

licenses.
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41383 When the ACQUITY SM-FTN Instrument Control Software (ICS) version
1.5 or greater is installed, Empower 3 software no longer allows a user to
enter an incorrect injection volume when the sample manager is in Full
Loop mode.

41661 When two GPC results are reported together and the first selected result
is associated with a GPC calibration curve with points, and the second
selected result is associated with a GPC calibration curve without points,
the GPC Calibration Table report group now reports the correct results for
GPC calibration curves that do not have points.

41807 The ApexTrack Peak Width value now determines more accurate inflection
points, thus producing more accurate plate count and resolution values.

For all ApexTrack peaks with an Integration Type of BB, the software
attempts to recalculate the inflection points using a peak width that is
optimized for the integrated peak rather than determining the inflection
points using the Peak Width parameter within the processing method (as
in past revisions of Empower). If successful, the recalculated inflection
points are used to calculate the Inflection Width, the optimized peak width
value is provided in the peak's Optimized Peak Width field which is new in
Empower 3 and the peak gets an S53 processing code indicating the
peak's inflection points were determined using the optimized peak width.

When compared to previous versions of Empower, Inflection Width and
the 5 fields that are calculated using Inflection Width-- Width @ Tangent,
USP Resolution, USP Plate Count, Width @ Tangent (USP Plate Count),
and Relative Resolution (when the Pharmacopoeia type in the processing
method is set to USP)-- could be different due to recalculating the
inflection points using the optimized peak width. These values have
improved accuracy when the Peak Width parameter used in the
processing method is inappropriate for the peak(s).

In Review and QuickStart, the Empower 3 software no longer displays a
message box with the warning "Warning: This ApexTrack result was
obtained using a Peak Width value that differs significantly from the Auto-
Peak Width value calculated for the channel.

42091 The "ORA-01461: can bind a LONG value only for insert into a LONG
column” error message no longer occurs during processing, and results
are produced as expected.

42324 The message “"One or more Accuracy channels were processed multiple
times in the result set” is now classified as a warning instead of an error.
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42393, 44910 | Projects with names that differ only in letter case can no longer be moved
to another parent project that contains a project with the same name. For
instance, the project "Quality_lab_2009" can no longer be moved to a
parent project that contains a project named "Quality_LAB_2009" by
changing the "Quality_lab_2009" project's parent (in project properties).
In previous versions of the software, both projects in this example could
subsequently be moved to the same level by modifying project properties.
Deleting one of the projects deleted the other project.

42485 Extracted PDA chromatograms no longer display incorrect run times when
higher sampling rates are used.

42959, 43417 | In previous versions of Empower software, enabling the Require User
Comments system policy resulted in a Comments dialog box and a
Revision History dialog box. However, after restoring FAT projects from
Empower to Empower 2, the Revision History dialog box did not appear
when a method was copied from a restored project into a new project.
Empower 3 software allows both method comments and audit trail
comments for methods.

42989 A Procsrvr MFC application error no longer occurs when attempting to
print or report an instrument method containing a deactivated (Off)
SAT/IN2.

43070 If you used the QuickStart Make Single Injection function in a GPC-

enabled project that used an inject function of "Inject Broad Samples,"
the sample type for the first sample injected was defined as a “Broad
Unknown.”; however, subsequent injections of the same sample type
were incorrectly defined as an “Unknown.”. Subsequent injections of the
same sample type are now correct.

43426 In the Processing Method Editor’s Suitability tab, the Noise Value for s/n
field is no longer cleared when US or Japanese pharmacopoeia are
selected. The s/n fields are now calculated for any of the pharmacopoeia
selections when the Noise Value for s/n field is not blank.

43592 A new processing system policy “"Enable Empower (1154) ApexTrack
Manual Integration” controls whether to perform ApexTrack manual
integration using the Empower ApexTrack manual integration code or the
Empower 2 ApexTrack manual integration code. By default, this system
policy is disabled. If you enable it, ApexTrack manual integration works as
it does in Empower (completely manually). If you disable it, ApexTrack
manual integration works as it does in Empower 2 (semi-automatically).

See also: "Manually altering integration” and * Setting up data processing
techniques” in the Empower 3 online information system.

44144 In some cases, database backups failed with error message "Backup
Database terminated with errors." These backups now function properly.
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44193 Empower 3 software now calculates USP signal-to-noise (S/N) according
to the latest USP definition (USP32-NF27 Supplement 2). The USP signal-
to-noise is calculated as follows:

S/N = 2h/hn
where:

h = the height of the peak corresponding to the component concerned

hn = the difference between the largest and smallest noise values
observed over a distance equal to at least five times the width at the
half-height of the peak and, if possible, situated equally around the
peak of interest.

44217 Using an individual report method to print data for sample sets containing
replicate injections no longer produces several copies of each result.

44226 Removal of the Method Validation Administrator user type no longer
causes upgrades to fail.

44287, 44310 | In Empower 2 FR5 systems with an €2695 or e2795 connected via
Ethernet, interactive flow changes no longer cause the Run Samples
window to become unresponsive.

44301 The Save Preferences function did not save the control panel
configurations in the QuickStart and RunSamples windows. The software
now saves the position and visibility states of control panels on a per user,
per application, and per system basis. These are saved automatically,
upon exit from the window, with no need to select the Save Preferences

menu item.

44666 In Review, when a 3D channel is derived from a 2D channel, the 3D
channel’s data rate is now calculated correctly.

44716 LDAP user account names are no longer required to have at least four
characters.

44829 When you import AIA data, Empower 3 software now issues an error and

terminates the import process if the data array type is incompatible with
the AIA chromatography template specification.

45207 When reporting a result set, the sample set method table now reports the
version of the sample set method that was used to process the data.

45404 When working with Empower System Policies, Other Policies, Force
Different Reasons, a combination of the length of the string and number
of strings selected as valid reasons for the Force Different Reasons no
longer causes the Configuration Manager application to exit and produce a
Microsoft Visual C++ Runtime Library error.

45502 When running two 2414 systems connected via Ethernet to the same
Empower acquisition computer, the injection sequence from one system
no longer causes a negative spike on the second system.
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45609 The MVM AQT report contained no reference to the processing node. The
validation results processing node now appears in the validation report
header.

45611 For Enterprise configurations with many licenses, the Waters Licensing
Wizard now prints all pages of the list of licenses.

45687 For 15xx pumps, the Run Samples interactive mode now displays the
correct flow rate for Pump C.

45689 Empower 3 software now includes an updated driver for the Configuration
13 LAC/E*2.

45901 You can no longer alter locked channels using the Alter Sample function.

46014 Empower 3 reports signed off in QuickStart and sent to SDMS now print to
SDMS Unify.

46148 Users with the View Multiple Projects Only privilege can no longer delete
channels in the Channel view or studies in the Validation Study view.

46294 In the Review and QuickStart windows, you can now scroll through the
injections displayed in the tree pane using the keyboard up arrow and
down arrow keys. You must first click in the tree to set the focus.

46376 When an LDAP group includes a group that is a parent group, Empower
can now successfully retrieve the LDAP tree info.

Known issues in Empower 3 software

The following table contains a list of the known issues and workarounds in Empower 3
software. The PCS (Product Change System) numbers identify software issues that Waters
personnel monitor within a system change request tracking tool.

Empower 3 software and Instrument Control Software (ICS) Installation

PCS Number Description

46051 If you use Empower 3 software on a Windows 7 64-bit system, you cannot
install the NuGenesis Unify driver. Contact your Waters informatics Sales
or Support Representative for assistance.

46088 If you attempt to install the 8-port serial hub (ESP-8) device driver on a

computer on which the 8-port serial card driver is already installed, the
installation might fail.

Resolution: Remove the secondary IP address of 64.1.1.1 for the
network interface card (NIC), and then reinstall the 8-port serial hub
(ESP-8) driver. See the Waters Ethernet Instrument Getting Started
Guide for more information.
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46775 When you log in to an Empower 3 Workgroup or Enterprise system for the
first time after performing a system object import, the Message Center
displays the following message:

Oracle Error ORA-00904: "INVALIDPASSATTEMPT" invalid identifier.

Although the message is accurate, it appears only during the initial logon.

46794 Do not uninstall the Agilent LC Control software from a computer that also
hosts Empower 3 software unless you also uninstall Empower 3. If you
remove the Agilent LC Control software from an Empower 3 system, the
removal causes the Empower 3 Verify Files to fail.

Workaround: Remove the Agilent LC Control license without removing
the software for the instrument.

Note: To access the Agilent LC Control instrument Help, press F1 while
editing an instrument method containing an Agilent LC instrument.

47126 The Verify Files document does not include the “Installation Information”
and “The following product updates have been applied to this installation”
sections if Empower 3 software is installed after installing the Bing Toolbar
or Windows Live ID on the computer.

Prevention: When updating Java, ensure the Install Bing Toolbar option
is unselected. Do not download and install the Bing Toolbar or Windows
Live ID applications onto any computer on which Empower 3 software is
installed.

Resolution: Open the Windows Control Panel, select Uninstall a Program,
and then uninstall the Windows Live ID program. This corrects the
problem immediately; you do not need to restart the computer.

47128 During uninstallation of Empower 3 software, the Waters DHCP server
message "Could not delete service" sometimes appears. If this message
appears, click OK. The uninstallation continues and completes
successfully.

47154 The domain name reported in the Empower 3 installation log is that of the
user who performed the installation, which is not necessarily the same as
the domain in which the computer resides.

47204 When installing Empower 3 client LAC/E>? software on a computer that
previously contained Empower 3 Personal software, you must first remove
the TNS_Admin environment variable.

47212, 47213 | When executing a push install of Instrument Control Software (ICS) for
mass spectrometers, ensure that no other users are logged on to the
target (client) system. If the local admin user is logged on to the target
system during the installation, ICS installation sometimes fails.
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47223 If you attempt to log in to the Waters Licensing Wizard using a disabled or
removed account, the software displays an error message indicating that
the failed login attempt was due to your lack of Administrator privileges.
The message should indicate that the login was not permitted because
your user account was disabled or removed.

47278 After importing system objects from a previous version of Empower
software into Empower 3 software, the Waters Licensing Wizard
sometimes generates an empty activation file.

Resolution: Start Empower 3. When the Login window appears, click
Cancel, and then proceed with the normal license activation process.

47374 The Configure BusLAC/E button is removed from the General tab of the
Node Properties dialog box in Configuration Manager.

The BusLAC/E is installed and configured properly during the Empower 3
software installation as long as the BusLAC/E is present before starting
the Empower 3 installation.

To configure the BusLAC/E in the manner previously employed by the
Configure BusLAC/E button, access the acquisition node directly, right-
click the Computer icon on the desktop and select System Properties, and
then click the Hardware tab.

Recommendation: Install the BusLAC/E board in the computer before
you install Empower 3.

47400 When you run a system object export from an Empower 3 client, a blank
dialog box sometimes appears after you double-click watexp.exe.

Workaround: Click OK in the dialog box. The system object export
wizard then starts normally.

47401 When you run a system object export from a client, you need only the
System account password.

Communications

PCS Number Description

45834 When connecting an Empower node to an SQ or a TQ mass detector for
the first time, the message “"An unnamed file contains an invalid path”
appears. Click OK to close the message.

Empower establishes communication with the instrument and the
message no longer appears.
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45991 When your Empower system is configured with gas chromatography
instruments, the OK status displayed in the Instrument tab of the Node
Properties dialog box in Configuration Manager might incorrectly display
"No” when the instrument status is actually OK. The incorrect status does
not prevent data acquisition.

Workaround: If the Instrument tab of the Node Properties dialog box
reports “No” in the OK field for any GC instrument, but acquisition is
possible, it is acceptable to continue using the system. Restarting the
computer corrects the instrument status.

46487 Occasionally, it may take several attempts for Empower 3 software to
establish communication with the WFCIII and achieve successful status in
Configuration Manager.

To establish communication, close the Empower 3 software, restart the
computer, and then restart the WFC III.

47100 Empower 3 software is unable to establish communications with an MS
detector after Instrument Control Software (ICS) for unused MS detectors
is removed. The instrument’s OK status displayed in node properties is
"No", the Run Samples control panel is blank, and the Tune page cannot
be opened or is unresponsive.

This defect applies to all mass spectrometers supported by Empower 3
software (EMD1000, ZQ2000, ZQ4000, EMD3100, SQD, and TQD).

Workaround: Uninstall the ICS for all installed mass detectors, restart
the computer, re-install the ICS, and then restart both the mass detector
and the computer again.

47107 If there is no network adapter (network interface card, or NIC) present in
an Empower 3 Personal computer, or if the network adapter is powered off
or becomes powered off as a result of a power saving mode change, a
“Database connection terminated ORA-12571" message appears.

Resolution:

Power on the network adapter, or install the Microsoft Loopback Adapter

as follows:

1. Click Start.

2. In the Search box, type cmd.

3. In the results list, right-click cmd and select Run as Administrator.
4. At the command prompt, enter hdwwiz.exe.

5. When the Add Hardware Wizard appears, click Next.

6. Select Install the hardware that I manually select from a list
(Advanced).

7. Click Next.

8. In the Common hardware types list, select Network adapters.
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9. In the Manufacturer list, select Microsoft.

10. In the Network Adapter list, select Microsoft Loopback Adapter.
11. Click Next.

12. When the installation is complete, click Finish.

Confirm the successful installation of the loopback driver by right-clicking
Computer (on the Windows desktop), and then selecting Properties. Click
Device Manager, expand the Network Adapters node, and confirm that
Microsoft Loopback Adapter appears in the list.

System administration

PCS Number | Description

45754 If you import system objects from a version of Empower 2 software prior
to Service Pack G, and LDAP authentication is enabled, you must update
the LDAP information in Empower 3 software, or you will be unable to
create users or alter the LDAP account information for an existing user.

To update LDAP information:

1. In System Policies, access the User Account Policies tab.

2. Under LDAP Domain Manager, click the top blank line in the box, and
then click Edit.

3. On the Authentication Policies page, enter a domain name.

4. Enter the domain component information (for example,
DC=DomainName,DC=com).

5. In the Search Criteria box, remove the domain component information
(for example, DC=DomainName,DC=com) beside each line in the box.

46041, 46053, | Depending on the user account’s administrative privileges, Empower 3
47080, 47081 | software sometimes exhibits one or more of the following behaviors when
configured for use with a mass detector:

¢ The message "Cannot save Tune method, user does not have the
"Save Tune method" privilege" appears when you access Run Samples.

e The message "You must select (or enter) the name of existing
Calibration Reference." appears when you access the calibration dialog
box from the Tune page.

e A Microsoft.NET Framework message appears when you click the
W3100 control panel in Run Samples windows.

e The Microsoft.NET Framework message "Unhandled exception has
occurred in your application” appears. If you click Continue, the
application ignores the error and attempts to continue. If you click
Quit, the application closes immediately.

e The Reference files dropdown list is blank.

¢ The message "Acquity console client has stopped working - - -
appears.
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To ensure proper operation of Empower 3 software with mass detectors,
observe the following login guidelines:

TQD and SQD - You can log in to the domain using an account that does
not have Administrator privileges, but the account must have local
Administrator privileges. You can the log in to Empower 3 software using
an account that does not have Administrator privileges.

3100, ZQ, and EMD - You can log in to both the domain and the Empower
3 software using an account that does not have Administrator privileges.

46310 On an Empower 3 Personal installation, do not change the default
database password. Changing the password can cause a failure when you
try to restore the database.

Recommendation: In a Workgroup or Enterprise configuration, change
this password for security purposes.

46502 When configured in LDAP authentication mode using Windows 2003 Active
Directory and a user account configured so that the user is not allowed to
log into a particular Empower workstation, Windows does not pass the
"User not authorized to logon from this workstation" error to Empower 3
software. As a result, the user is allowed to log in to Empower 3 software.
This Empower problem results from the Microsoft defect.

46603 When logging in to Empower 3 Client/Server or Workgroup software on
supported Asian language Windows versions (Simplified Chinese,
Japanese, and Korean), an Oracle error (-1) occurs if the database alias
has the same name as the local computer. This problem is caused by an
Oracle defect.

Workaround: Ensure that the database alias name is different than the
local computer name.

46720 When you run Net Configuration Assistant on a Windows 7 system, the
screens might not display correctly. For example, the title of the screen
might not pertain to the body text.

Workaround: Close the Net Configuration Assistant and run it again.

47380 You cannot start the Empower 3 database from Oracle Enterprise Manager
(OEM). Instead, use Services in the Windows Administrative tools to start
and stop the Oracle service. See the Empower System Administrator’s
Guide for more information.

47404 In Empower 2, the “"System” user was included by default in the

administrators user group. In Empower 3, no default users are included in
the administrators user group. You must manually add the “System” user
to this group, unless you are importing system objects from Empower 2..
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Backing up and restoring projects

PCS Number | Description

45970 When the SDMS option "Archive When Project Deleted" is enabled,
projects deleted using the Configuration Manager do not appear in the
table view, but remain in the tree view.

This behavior occurs because the table view does not show projects that
are awaiting deletion. Because projects are not fully deleted from
Empower until the SDMS archiving completes, they remain in the tree
view.

After the archive operation is complete, refresh the project tree by
collapsing and uncollapsing it, or by restarting Configuration Manager. The
list of projects is then correct.

46377 After configuring a valid NuGenesis server URL in the NuGenesis SDMS
Archive Properties dialog box, the message "Invalid URL" sometimes
appears when you select or deselect the Archive when Project Deleted
option.

Resolution: Click Connect to reconnect the URL.

46545, 46774 | When using the Backup and Restore Wizard to restore a large batch of
projects, the window response is sometimes delayed. If you click your
mouse during the restore process (for example, if you click outside of the
project window), Microsoft Windows displays the following message:

“"CONFIGMGR MFC Application is not responding”

Workaround: When this message appears, do nothing, or click “*Wait for
the system to respond.” The message closes and the restoration
continues.

46641 The Backup Project wizard might fail when the project you select for
backup has sub-projects, and you press F1 to access Help at the following
prompt:

"At least one of the selected projects contains one or more sub-projects.
Do you want to backup the contained sub-projects also?"

Resolution: If the Backup Project Wizard has exited or is unresponsive,
restart the backup operation.

47065 To minimize user interaction when restoring batches of projects, Empower
3 software sets the time zone for restored projects without time zones to
the time zone of the node (client, etc.) from which the project restore
operation was initiated. Previous versions of Empower software prompted
the user to select the time zone for the first project restored as part of a
project update during a batch restore.
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47193 Project restoration from a Citrix client is delayed and the project hierarchy
is sometimes not restored. When clicking through the Restore wizard,
there may be significant delays, and the status sometimes indicates that
the window is not responding. This behavior occurs when the projects to
be restored are local on the Citrix client.

Workaround: When restoring from a Citrix client drive, do one of the
following:

e Ensure the Citrix client is part of a domain that has a trust relationship
with the Citrix server and is logged into that domain. If the client and
the server reside in separate domains with no trust relationship, the
project restoration might fail.

e Copy data to be restored to a network share in the same domain as
the Citrix server.

47382 Sub-projects do not appear in the list of projects being restored when the
following circumstances exist:

e The projects being restored are located directly within a drive’s root
directory.

e Only the first project’s directory (listed alphabetically) contains sub-
projects.

¢ No other project hierarchies are located in the root directory.

Workaround: In the root directory, create an empty folder with a name
that is alphabetically before the top-level project folder.

Data acquisition

PCS Number Description

34576 If you run a sample set containing a method in which the “lamp on”
option is disabled, the sample set completes with an instrument failure
and the “Lamp off during acquisition” message appears.

This occurs when you:

e Deselect the “lamp on” option in a shutdown method. This error occurs
even though the shut-down method does not collect samples.

e Program a “lamp off” event before the run time is complete. In this
case, you can correct the problem by altering the method so that the
“lamp off” event occurs after the run time expires.
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45349 When using Empower 3 Personal software with an instrument system
connected via Ethernet, do not open multiple copies of RunSamples to
acquire data in different projects using the same chromatographic system.
If you do, the instrument becomes unresponsive, sounds a continuous
alarm, and displays the following message:

“Please cycle power. Unable to continue due to error in Vrtx Task
capRunner3: Assertion failed:(runnerLock.Lock()==0k)file evntrun.cxx,
Line”

In the Empower Message Center, the following error appears:

“Lost communication, instrument error.”

46239 Empower 3 software can acquire data from only one Quaternary Gradient
Module (QGM) system at any given time. If you attempt to acquire data
using two QGM systems, the first system might not complete the
acquisition.

46746 When the % Monitor collect between windows parameter is set to 100%,
the collection peaks appear as square waves in the Run Samples real-time
plot. Because the WFCIII displays data in 1-second intervals, fractions of
seconds are displayed as collection peaks. This is the expected behavior.

46871 The Waters Fraction Collector III (WFCIII) skips the first collection vessel
if both the Skip per Inj and Monitor collect between windows options are
enabled in the instrument method. This is the expected behavior.

46926 When you change an instrument method that is actively being used for
acquisition, your changes do not take effect until the next sample set is
run or until you stop and then resume the current sample set. For the
changes to take effect during the current acquisition, you must make
them using the Alter Running Sample function.

46962 When specifying special vials 1 through 4 in the Run Samples window
Single tab or the QuickStart single injection window, use the following
format:

V:position

Where position is the sequential location of the vial in the sample tray.
For example:

V:l
V:2
V:3
V:4

If you use the wrong syntax, the message "The position must begin with
the plate number followed by a colon" appears when you attempt to
inject.
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47018 Empower 3 software displays the total time remaining for queued sample
sets in days, hours, minutes, and seconds. Previous versions of Empower
software displayed the time in hours only.

Method development

PCS Number | Description

35915 You can use the “&"” character to create comments; however, when you
print the comment to a report, that character is not displayed.

46219 In an environment that contains multiple Quaternary Gradient Modules
(QGM) that share instrument methods, when editing a QGM instrument
method, the instrument method editor sometimes displays a generic
method editor with incorrect flow rate ranges and flow scale parameters.
When printed, the instrument method reflects the system for which it was
created, regardless of the system on which it was run. These behaviors
occur when the instrument method was created on a mismatched QGM
system.

To optimize the use of QGM instrument methods across Empower
systems, ensure the system properties include the same instrument
types, listed in the same order, and that the QGM models are identical.

46220 When you create or save an instrument method that includes a
Quaternary Gradient Module (QGM), and then attempt to close the
instrument method without making changes, the software prompts you to
save changes.

46691 When using the Method Properties dialog box to compare methods from a
system with a Sample Manager - Flow Through Needle (SM-FTN),
Quaternary Solvent Manager (QSM) and Photodiode Array Detector (PDA),
configured in that order, the software fails if you choose the second
method version before the first one in the Method Properties dialog box,
and then click Differences.

46713 If you use the Method Differences function to compare an instrument
method that includes a Quaternary Solvent Manager (QSM) with a method
that does not include a QSM, the project.exe application fails.
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Data processing

PCS Number | Description

45275, 45276, | Empower 3 software is built using a different compiler than previous
46551 versions of Empower and Millennium software. The compiler used to build
Empower 3 software allows separate settings for improved floating point
precision and for faster speed of execution. Earlier compilers allowed only
a single compiler setting for either improved floating point precision or
faster speed of execution.

Empower 3 software is optimized for both improved floating precision and
faster speed of execution. Because previous versions of Empower and
Millennium software were optimized only for speed of execution, results
produced by Empower 3 software might not match results produced using
previous versions of Empower and Millennium software.

For more information, see "Empower calculation considerations”.

46168 To ensure that you have adequate computer resources to view a large
number of large data files (for example, 3D files with long sample run
times with data collected at the maximum data rate) in Review or
QuickStart, do one or more of the following:

e Increase virtual memory to 10 times the size of the RAM.

e Access the Method Set Options dialog box in Review by selecting
Options > Method Set Options. Clear the "Automatically apply
method set" check box, exit Review or QuickStart, and then open
Review or QuickStart to view the data.

¢ In Windows 7 systems, select a basic operating system theme.

46583 Empower 3 software allows only one sample set or result set in Review
and QuickStart at one time. Previous versions of Empower software
allowed multiple sample or result sets in Review and QuickStart.

If you attempt to bring two sample or result sets into Review or
QuickStart, the software rejects the second set. If you have a sample or
result set in Review, and you attempt to bring in an additional sample or
result set, the software rejects it. If you attempt to bring a sample or
result set into QuickStart when a data set of the same type is already
loaded, you can choose to replace the existing data with the data from the
selected set or to keep the data already loaded.

Workaround: Create a process-only sample set from the sample sets you
want to bring into Review.

46715 Previous versions of Empower software allowed you to drag and drop
invalid file types (.ARO, .AR1, .AR2, .AR3, and .AR4) into the Project
window. Invalid file types are not allowed in the Empower 3 Project
window.
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46730 In Empower 3 MVM Linearity results, small negative (107'%) skew values
do not match corresponding skews calculated in JMP® 6.0. However,
larger, positive skew values in Empower 3 software match corresponding
skews calculated in JMP 6.0.

This behavior occurs only for skews. All other statistical calculations
(mean, standard deviation, etc.) for the same linearity results match JMP
6.0 calculations.

46836 In Empower 3 MVM Linearity of the method results, the Intercept value in
the Regression Coefficient Table does not match the JMP, Excel, or Table
Curve intercept value. Because the MVM result's curve intercept value is
so close to zero, Empower 3 software calculates it differently than other
software.

46857 On Empower 3 Windows XP clients, background processing may not work
as expected if you use the TNS_ADMIN environment variable to define the
net service name.

Workaround: Specify the computer name instead of an IP address when
defining the TNS_ADMIN variable.

46914 When performing a Linearity test in Empower 3 MVM software, the value
in the Variance Cochran Test Ref field sometimes does not match the
accepted documentation?® to the fourth significant figure. At other times,
the value matches appropriately.

Because the accepted documentation pre-dates chromatography data
systems, the values calculated by Empower 3 software are likely to be
more accurate than the numbers in the accepted Cochran table.
Discrepancies are random and could be caused by rounding error.

! Statistical Principals in Experimental Design, Third Edition, by B.J.
Winer, Donald R. Brown, Kenneth M. Michels.

47007 During processing, when the available tablespace for a project falls below
10 MB, the software should halt processing and display the “Available
table space below minimum level to continue processing. Processing
aborted” message in the Message Center. Instead, processing continues
until the available tablespace for the project falls below 0.5 MB, at which
point the “Oracle error ORA 01536;Space quota exceeded for table space
USER_DATA"” message appears.

47072, 46997 | In the Method Validation Regression Coefficient Table, Empower 3
software recalculates the t-Ratio, p-Value, and lower and upper confidence
values for both the intercept and the slope using the reported slope and
intercept values (calculated using the curve fitting routine).

Empower 2 software did not recalculate these values and reported the
values calculated using the statistical routine.
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47224 When creating a new processing method, the Spectra to Average field in
the MS processing method's MS Library Search tab defaults to 5. In earlier
versions of Empower software, the Spectra to Average field defaults to 1.
The Empower 3 online Help for the MS Library Search Tab incorrectly lists
the default as 1.

46343, 47261 | In the process-only sample set editor, if you split replicate injections into
separate sample lines, the component editor shows the components for
the first injection of the replicates, even when you select a subsequent
replicate.

Workaround: View component information in the Alter Sample Editor.

47375 When you attempt to display many large 3D and 2D channels in Review,
"Data Missing" appears in the 3D and 2D plots, an MEM processing code is
added to the Result Codes in the Chromatogram Result table in the Result
Window, and the following messages appear in Message Center:

e Chrom map view of file failed.
e Not enough storage is available to process this command.

The “Data Missing” error is incorrect; no loss of data occurs.

Workarounds:

e Bring smaller groups of data into Review.

e Bring a sample set or injections instead of channels, and a result set
instead of results into Review.

47379 In the multi project mode, the Project windows fails when you select
Remove All Projects from the Global Projects branch or when you click the
Deactivate All button in the Project Available tree view (View->Toolbar-
>Project Available) and then try to reactivate a project.

Workaround: Remove and activate projects individually in the Projects
Available tree view.

47406 In Empower 3 simplified Chinese software, the translation of the Lower
Error Limit (LCL) Method Validation field name is incorrect and is not
consistent with the translation of the Upper Error Limit (UCL) field name.

Configuration Manager

PCS Number Description

46297 To import the sample plate file for the Waters 2707 autosampler
(“"W2707_Plate_Type.txt"), your Empower 3 software must be the same
language version as the system from which the sample plate file was
exported. If you attempt to import a sample plate file from a different
language version, the system issues the following message:

'unexpected file found'
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Re

46589

If you attempt to clear an offline system audit trail while a view filter that
displays no entries is applied, Empower 3 software displays a message
indicating that there are no records to clear. This message appears even if
the database contains entries eligible to be cleared.

To clear an offline system audit trail, select a view filter that displays at
least one entry, then clear the audit trail. All entries are then cleared,
regardless of which entries appear in the current view. To ensure
regulatory compliance, Empower 3 software clears all records; you cannot
selectively clear individual entries.

46945

By design, the Configuration Manager displays eCord column pressure in
psi regardless of the type of units selected and displayed in the ACQUITY
UPLC console. Although the Configuration Manager uses a different unit of
measurement than the ACQUITY UPLC console, the data that the
Configuration Manager displays is correct and equivalent to the
measurements presented in the ACQUITY UPLC console.

47196

The eCord Summary information in Configuration Manager may not
update properly if more than one sample set runs to completion while the
acquisition server is buffering data. The eCord summary information will
be displayed properly when a new sample set or a single injection is run
when the acquisition server is no longer buffering.

47329

When Configuration Manager is simultaneously open on two nodes (either
a client and a server or two clients), the list of projects shown in editors
such as the New Project Wizard can be inaccurate when projects have
been created or deleted using a node other than the node on which the
list of projects is viewed.

Workaround: To ensure the latest project information is displayed, shut
down and restart Configuration Manager.

porting

PCS Number

Description

45475

In Empower 64-bit installations (Windows 7), reports sometimes do not
display or print properly when the font setting in the Windows Control
Panel is 150%. Reports sometimes appear truncated because they do not
use the full length and width available for the paper.

This behavior does not occur on Empower 3 software installed on 32-bit
versions of Windows XP, or if you use a Windows XP computer to remotely
access a Windows 7 64-bit computer.

Workaround: In Windows Control Panel, access the font size setting by
selecting Appearances and personalization > Display, and then selecting a
size setting other than 150%.

47318

Adobe Acrobat must be installed on your computer to view signed off
reports in Report Viewer.

Refer to the Adobe web site if you do not have Acrobat installed on your
system.
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Custom fields

PCS Number | Description

46853 Some Empower 2 and Empower 3 Korean default projects have an
improper translation of the sample weight field name. The correct
translation is sample weight; the incorrect translation is sample mass.
Any projects cloned from these affected projects also have the improper
translations.

Empower 3 projects with the incorrect translation include:
Custom_fields

Defaults_FAT

GPCVLS_Default

GPC_Default

LIMS_ASCII_Andi

LIMS_LabSystems

PDA_Default

SysSuit_Default

ZQ_Default

Workaround: Before copying data from one of the affected projects,
correct the sample weight custom field name in the source project so that
it matches the translation in the destination project.

47264 An Improper Argument error sometimes appears when you access the
custom field editor in the following manner:

1. In the Project window, access the Custom Fields tab.

2. Double click a custom field. The Project Properties dialog box opens in
Configuration Manager.

3. Close the Project Properties dialog box.

4. 1In the Configuration Manager project list, right-click a different
project and select Properties.

5. In the Project Properties window, click the Custom Fields tab.

If the custom field that was opened in the first project does not exist in
the subsequently opened project, the Improper Argument error appears.

Workaround: Start the custom field editor from Configuration Manager
rather than from the Project window.

47402 In the Japanese version of Empower 3 software, the translation of the
"Injection" field does not match the translation in Empower 2. After
upgrading your Empower 2 data to Empower 3, if you have custom fields
that are defined using this field, you might need to update those custom
fields to use the Empower 3 translation of the "Injection" field.
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47407 PDA field names were changed in Empower 2, Feature Release 4 software.
If you have custom formulas that reference PDA field nhames, you must
manually update them for custom formula calculations to generate results
correctly.

Toolkit

PCS Number | Description

45955 The Intervals class, which was used only with the Pattern Matching
option, is obsolete. If your Empower Toolkit applications use the Intervals
class, you must rename the class and recompile the application.

47408 To view the Toolkit Professional Help file (miltk.chm), copy the file from
the Toolkit media to your computer, navigate to the file in My Computer,
and then double click it.

Qualification

PCS Number | Description

47052 The Automated Qualification Tool (AQT) for SAT/IN is not compatible with
Empower 3 software.

Online Help

PCS Number Description

44321 The Empower 3 online Help contains inconsistent units for the peak fields
"Slope" and "Offset".

"Slope" refers to the slope of the baseline drawn beneath a peak, or peak
cluster, based on how it is currently integrated. Slope units are the y-axis
units divided by minutes. In some cases, the online Help lists Slope units
as microvolts/second, uv/second, or plot units/minutes.

"Offset" refers to the y-intercept of the baseline of a peak or peak cluster
extrapolated to time zero. Offset units are the same as the y-axis units.
In some cases, the online Help lists Offset units as microvolts, uv, or plot
units.
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GxP compliance requirements

When you install Empower Software for the first time, or when you uninstall software, Waters
recommends that you perform software qualification to meet GxP compliance requirements.
Any time you install or uninstall software in a GxP environment, Waters recommends that you
follow your company’s management-approved software change management standard
operating procedures.

To verify that the installation of Empower 3 software does not affect any data, reprocess a
data set before and after you install the software, and then verify that the results are
equivalent.

Waters recommends that you run either the Verify Files utility or the ConnectionsAQT for
Empower IQ. After you run one of these utilities, review the resulting checksum.txt file for an
entry that states “"No installation changes were detected.”

In a GxP-compliant environment, Waters recommends enabling the Disallow Use of Annotation
Tools system policy. Enabling this policy prevents all users from using the Annotation tool in
Report Publisher and in Review. You access the system policy options by selecting View >
System Policies > Other tab in Configuration Manager.

Post-installation considerations

Activating licenses and options

Empower 3 installations require using the Waters Software License Management System to
register, activate, deactivate, and view Waters software licenses and options. Key disks are
unavailable for Empower 3 software.

For detailed instructions on using the Waters Licensing Wizard, see the Empower 3 Installation
and Configuration Guide, Revision A, on the Empower 3 Documentation media.

Option changes

The following options, which were available in previous versions of Empower software, are not
available in Empower 3 software:

e Webserver
e Pattern Matching

o Data converter options, including Waters Data Converter, AccessChrom, ChemStation,
and MassLynx Data Converter. As a result, the Import MassLynx Data and Waters Data
Converter selections have been removed from Empower 3 menus. These options will be
replaced by the Waters Data Converter 2 (WDC 2) software.

In addition, the GPC, GPCV, and GPCVLS options have been replaced by the GPC/SEC option.
No GPC, GPCV, or GPCVLS functionality was changed as a result of this change. These options
continue to be enabled on a per-project basis within the project properties.
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Configuring projects

In Empower software, chromatographic data and metadata are organized into projects. When
Empower 3 software is first installed, no projects are configured. You use Configuration
Manager to create new projects or restore projects from previous versions of Empower
software. The Empower 3 Default Projects media, provided in the Empower 3 software kit,
includes example projects you can restore to your Empower 3 system.

For information regarding creating and restoring projects, see the “Creating Projects” and
“Restoring Projects” topics in the Empower 3 online information system.

Installing Waters NuGenesis SDMS data adapters

The Empower Remote Data Adapter and Empower Restore must be installed on a computer
running the Empower 3 Enterprise client. Data capture from Empower 3 Personal software into
SDMS is not supported.

As of this release, the Empower Remote Data Adapter software is supported on English and
Japanese language versions of Microsoft Windows. NuGenesis VISION and UNIFY are
supported on English, Japanese, Chinese, and Korean language versions of Windows 2003 and
Windows XP.

In general, the steps to install NuGenesis SDMS data adapters are:
1. Install SDMS 7.1 remote data adapters.

Note: When installing remote data adapters, select Waters Corp. Empower-2 (Remote).
This data adapter has been structurally validated with Empower 3 Enterprise software.

2. Install the NuGenesis Transfer application.
3. Install SDMS Data Adapters.

Note: When installing SDMS Data Adapters, select Data Restore, then select Waters
Corp. Empower-2 0 Restore.

4. Install service release 6 (or later).

After you install the NuGenesis SDMS Data Adapters, you may see an error when you run the
Installation Qualification. If this error message appears, click “This program is installed
correctly”.

To run the Data Adapters, you must disable your Windows firewall or configure it to allow the
following programs:

C:\Program Files (x86)\NuGenesis 7.1\EVS\ng7O0DMEVSEmp2SVR.exe
C:\Program Files (x86)\NuGenesis 7.1\EVS\ng70EVSEmp2Svr.exe
C:\Program Files (x86)\NuGenesis 7.1\PM\NG71latbld.exe

In the "Allowed programs and features" list, select the Domain, Home/Work (Private), and
Public check boxes for each of the programs listed above.

For more detailed instructions, refer to the SDMS 7.1 Service Release 7 Release Notes.
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Empower 3 performance considerations

Empower 3 performance testing has shown differences in two key areas as compared to
Empower 2. This is reported in the Waters tracking system as PCS 47381.

General performance in a 64-bit environment

Empower 3 is a 32-bit application that can be run in a 32-bit Windows XP or a 64-bit Windows
7 environment. The computer industry reports that launching an application in a Windows 7,
64-bit environment can take up to seven seconds longer than launching the same application
in @ Windows 32-bit environment. In our evaluation labs, launching Empower 3 applications in
a Windows 7, 64-bit environment sometimes took a few seconds longer than launching
Empower 2 applications or Empower 3 applications in a Windows XP, 32-bit environment.
Additionally, the Windows 7 64-bit operating system reportedly reduces overall performance
for 32-bit applications by 2% compared to its 32-bit predecessor, Windows Vista.

Recommendation: Set the computer power options to High Performance. For Windows 7,
open Control Panel, select Power Options, and then select High Performance.

References:

Windows 7 Performance Tests: Odd One Out: Application Launch Times
http://www.pcworld.com/article/172509-2/windows_7_performance_tests.html
Optimization of 64-bit programs
http://www.start64.com/index.php?option=com_content&task=view&id=2889%Itemid=126
32-bit vs. 64-bit: More Bit, More Performance?

http://blog.tune-up.com/windows-insights/32-bit-vs-64-bit-more-bit-more-performance/

Project restoration
Restoring pre-Empower 3 projects

Restoring a project backed up in a previous version of Empower software to Empower 3
software can take 2- to 5- times longer than restoring the same project (or equivalent) to
Empower 2 software. During the restoration of a pre-Empower 3 project, Empower 3 updates
the project, to ensure database compatibility. Restoring a project created in Empower build
1154 or Millennium?? requires more extensive project updates and therefore takes longer than
restoring a project created in Empower 2. Restoration times for groups of larger projects tend
to fall on the low end of the 2x — 5x time range, whereas restoring batches of multiple small
projects tend to fall on the high end of the range. The reason for these tendencies is that
Empower 3 must perform certain restoration operations for each project in the batch,
regardless of the amount of data the project contains.

Restoring Empower 3 projects

Restoring projects that were backed up in Empower 3 takes approximately 25% more time in
a Windows XP 32-bit environment and approximately 50% more time in a Windows 7 64-bit
environment compared to restoring a project that was backed up in Empower 2 and restored
into Empower 2.
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General project restoration information

The challenge caused by the increased time required to restore projects into Empower 3
software is offset by the capability to perform unattended batch project restoration. In
previous versions of the software, the batch-restoration process produced error and
informational messages that required user intervention. In Empower 3 software, however,
these messages are logged silently and require no user intervention.

Empower calculation considerations

When you use Empower 3 software, you may see differences in some numeric calculations due
to the software compiler used with Empower 3.

Differences observed when comparing results obtained in Empower 3 with those obtained in
Empower 2 are reported in the Waters PCS system as 45275, 45276, 45585, 46551, and 47072.

Software Compilers

Empower build 1154 software and Empower 2 build 2154 software were compiled using an
option for better speed during processing. The compiler used did not have a separate option to
compile based on precision.

Empower 3 software is compiled using an updated compiler within Microsoft’s current
development tool suite. The same compiler options as used previously are not available. This
compiler has an option that increases precision and provides the best compromise between
floating point precision and execution speed.

Numeric Differences

When Empower results are compared for accuracy to those produced by another software
package such as Excel or JMP, Waters’ testing approach requires humbers to match to 7
significant digits for iterative calculations and to 9 significant digits for non-iterative
calculations. Waters’ testing approach used to compare numbers between different versions of
Empower software typically requires all floating point digits to match. Although the Empower 3
compiler change results in several Empower 3 values not matching their Empower 2
counterparts, these values exceed the requirements of matching third-party software and
remain within the variation that is expected when using a different compiler.

The numeric changes that were observed are primarily for values determined using iterative
calculations such as calibration curve coefficients or calculations that depend on calibration
curve coefficients such as MVM Linearity results.

Based on these results, Amounts (X Values) calculated using calibration curves in Empower 3
and displayed with the default precision of 6 are not expected to differ from Amounts (X
Values) calculated in Empower 2.
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Out of thousands of automated testing benchmarks, only the following result determinations

were found to be different in Empower 3 as compared to Empower 2:

Result

Difference in
precision
compared to
Empower 2!

Difference in
significant
digits compared
to Empower 22

# of occurrences out
of # of tests

Area 0 16 2 out of 1389
Start Height 0 >17 1 out of 77
End Height 0 >17 1 out of 77
Coefficient A for a 9 12 1 out of 64
weighted cubic

curve

Slice Observed [n] 6 11 4 out of 1127

(dl/g)

Results in MVM Linearity Regression Coefficient table

F Ratio Reference 12 14 2 out of 26
Quadratic Effect F- 12 14 1 out of 1
Ratio Reference

Calculated Y Value 10 15 3 out of 28
gz]lculated Y Value 9 15 1 out of 28
UCL

Residual 9 11,12,13, and 14 9 out of 28
Residual Mean 9 13 3outof 6
Residual % Bias 12 12 1 out of 6
Residual SD 11 15 1 out of 14
F-Ratio 9 15 1 out of 26
Slope SD 12 15 2 out of 10
Slope CI 10 15 3 out of 10
Intercept 10 13 and 14 2 out of 10
Intercept SD 11 15 2 outof 9
Intercept CI 9 15 3 out of 10
Intercept % Bias 12 12 1 out of 10

! The position to the right of the decimal place where the difference in the Empower 3 value occurred as
compared to the Empower 2 value. Zero means that the difference occurred immediately before the
decimal.

2 The position, as a significant digit, where the difference in the Empower 3 value occurred as compared
to the Empower 2 value.
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Using Empower 3 online Help

The Empower 3 Online Information System is designed to answer your questions while you
work with Waters Corporation products and the Empower product suite.

When you press F1 in an Empower 3 software window or click the Help button in a dialog box,
you have access to reference information for that application. To access additional information
for Empower tasks, from the Empower Help menu, click Empower Help Topics. When you want
to quickly find information, you can conduct a search for specific word(s). When searching for
a phrase, enclose the phrase within double quotation marks, for example, “interpreting
processing codes”.

For more information about using the Empower 3 online information system, see the
“Welcome to our Online Information System” topic.

Other useful topics for getting started with Empower include: “Managing Projects”, “Creating
User Accounts”, “"Acquiring and analyzing chromatographic data” and “Using a quickstart
guided tour to learn about Empower.”

Test configurations

The following test configurations were used during the development and evaluation of
Empower 3 software.

Windows XP (Client or LAC/E>?)
Operating system: Windows XP Professional SP3 (32-bit)

Windows hotfixes: KB953297, KB953595, KB958484, KB963707, KB927978, KB936181,
KB954430, KB973688, KB933579, KB892130, KB933566, KB938127, KB942615, KB950759,
KB953838, KB969897, KB980182, KB923789, KB929399, Windows Imaging Component,
KB936782, KB905474, KB939683, KB941569, KB951698, KB951376-v2, KB950760,
KB951978, KB951748, KB950762, KB952954, KB946648, KB952287, KB953839, KB951072-
v2, KB950974, KB951066, KB955839, KB956572, KB955069, KB956802, KB954600,
KB954550-v5, KB957097, KB958644, KB958687, KB938464-v2, KB959426, KB959772,
KB960225, KB960803, KB954459, KB923561, KB961373, KB961501, KB967715, KB954154,
KB968537, KB952069, KB952004, KB969898, KB956803, KB970238, KB971468, KB971657,
KB971961, KB972270, KB973354, KB973507, KB973540, KB973687, KB973815, KB973869,
KB973904, KB974112, KB974318, KB974392, KB974571, KB975025, KB975467, KB975560,
KB975561, KB975713, KB977165-v2, KB977914, KB978037, KB978251, KB978262,
KB978706, KB979306, KB969947, KB968816, KB968389, KB961118, KB960859, KB958869,
KB956844, KB956744, KB954155, KB955759, KB969059

Windows 7
Operating system: Windows 7 Professional (64-bit)

Windows hotfixes: KB971033, KB2032276, KB2079403, KB2160329, KB2183461,
KB2272691, KB2286198, KB2347290, KB958488, KB971468, KB972270, KB973525,
KB974332, KB974431, KB974571, KB975364, KB975467, KB975496, KB975560, KB976098,
KB976264, KB976325, KB976662, KB977074, KB977863, KB978207, KB978251, KB978262,
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KB978506, KB978542, KB978601, KB978637, KB978886, KB979099, KB979306, KB979309,
KB979482, KB979683, KB979900, KB979916, KB980182, KB980195,KB980218, KB980232,
KB980302, KB980408, KB980436, KB980846, KB981078, KB981332, KB981793, KB981852,
KB982110, KB982214, KB982664, KB982665, KB982799, KB983590

Operating system: Windows 7 Enterprise (64-bit)

Windows hotfixes: KB971033, KB2032276, KB2079403, KB2158563, KB2207566,
KB2272691, KB2281679, KB2286198, KB2296011, KB2345886, KB2347290, KB2360131,
KB2362765, KB2378111, KB2387149, KB2416471, KB958488, KB971468, KB972270,
KB974332, KB974431, KB974571, KB975467, KB975496, KB975560, KB976098, KB976264,
KB976422, KB976662, KB977074, KB977863, KB978207, KB978251, KB978262, KB978506,
KB978542, KB978601, KB978637, KB978886, KB979099, KB979306, KB979309, KB979482,
KB979538, KB979683, KB979687, KB979688, KB979900, KB979916, KB980182, KB980195,
KB980218, KB980232, KB980302, KB980408, KB980846, KB981078, KB981332, KB981852,
KB981957, KB982110, KB982132, KB982214, KB982665, KB982799, KB983590

Windows Database Server 2008
Operating system: Windows Server 2008 Enterprise (English), R2 (64-bit)

Windows hotfixes: KB982519, KB982381, KB981793, KB980218, KB980195, KB979916, KB979559,
KB987482, KB981332, KB980408, KB980232, KB980182, KB979683, KB979309, KB978601, KB978542,
KB979306, KB978262, KB978251, KB978207, KB976662, KB975560, KB975467, KB974571, KB974431,
KB971468, KB981390, KB977239, KB977238, KB977236, KB981392, KB981391, KB987632, KB978637,
KB978506, KB977074, KB976264, KB979099, KB976098, KB975364, KB974332, KB973525, KB972270,
KB982519, KB980846, KB979900, KB958488, KB981111

Oracle version: 11.2.0.1.0

Citrix Servers
XenApp 6.0
Operating system: Windows Server 2008 Enterprise (English), R2 (64-bit)

Windows hotfixes: KB980408, KB978542, KB981390, KB977239, KB977238, KB981111,
KB977236, KB981392, KB981391, KB980302, KB980232, KB980182, KB979683, KB979309,
KB979306, KB978637, KB978601, KB978262, KB977074, KB976662, KB976264, KB975560,
KB971468, KB979099, KB981332, KB976325, KB976098, KB975467, KB975364, KB974571,
KB974431, KB974332, KB973525, KB972270, KB983590, KB982799, KB982664, KB982214,
KB981852, KB980436, KB978886, KB2286198, KB2183461, KB2160329, KB2079403,
KB2032276, KB982666, KB982519, KB982381, KB981793, KB980846, KB980218, KB980195,
KB979916, KB979900, KB979734, KB979559, KB979482, KB958488, KB981111, KB982632,
KB982132, KB982132, KB982110, KB981957, KB979688, KB979687, KB979538, KB2416471,
KB2398632, KB2387149, KB2362765, KB2360131, KB2347290, KB2345886, KB2296011,
KB2272691, KB2207566, KB2158563
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